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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
This guide covers the installation, configuration, and use of the softGear Streaming Gateway on an 
AWS™ EC2 instance. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Before You Begin” summarizes the features of the Streaming Gateway and provides a workflow 

example for the Streaming Gateway integration.
• “Getting Started” provides the software requirements, installation instructions for the Streaming 

Gateway and DashBoard, and instruction on connecting DashBoard to the Streaming Gateway.
• “Licensed Features” outlines the available software licensed features, and how to manage your 

software keys for licensed features.
• “Using DashBoard” provides instructions for launching DashBoard, and accessing the Streaming 

Gateway interfaces in DashBoard.
• “Configuring the NTP Settings” provides instructions for configuring the Streaming Gateway for 

communication with your facility NTP server.
• “Configuring the Source for a Connection” outlines how to configure a source by assigning an 

NDI stream as a source.
• “Configuring the Destination for a Connection” outlines how to configure a destination by 

assigning an SRT stream as a destination.
• “Connection Management” outlines how to enable a connection, edit an existing connection, 

disable a connection, and delete a connection.
• “DashBoard Interface Overview” summarizes the menus and parameters of the Streaming 

Gateway tabs in DashBoard.
• “Third Party Licenses” contains licenses for third party libraries that are used in the softGear 

Streaming Gateway.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Streaming Gateway:

• DashBoard User Manual, Ross Part Number: 8351DR-004

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Network tab, click Apply.

User Entered Text
Courier text is used to identify text that a user must enter. For example:



8 • Introduction Streaming Gateway Cloud User Guide (v1-rev1)

In the Language box, enter English.

Referenced Guides
Text set in bold and italic represent the titles of referenced guides, manuals, or documents. For 
example:

For more information, refer to the DashBoard User Manual.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts.

Contacting Ross Video Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Before You Begin
The softGear Streaming Gateway is a transport converter with built-in micro-services. The 
Streaming Gateway allows you to transport content based on softGear™ micro-service architecture, 
and can run on an AWS EC2 instance. 

If you have questions pertaining to the operation of the Streaming Gateway, contact us at the 
numbers listed in “Contacting Ross Video Technical Support”. 

Features
The Streaming Gateway includes the following features:

• Support for MPEG2-TS over SRT transmission
• Supports multiple resolutions and frame rates
• NDI reception
• Intuitive control and monitoring via DashBoard

DashBoard Interfaces
The Streaming Gateway includes DashBoard interfaces for configuration and operation. The 
interfaces are accessed by expanding the Streaming Gateway node in the DashBoard Tree View and 
selecting the appropriate sub-node. The DashBoard client software enables you to monitor and 
control DashBoard Connect compatible devices from a computer. 

For More Information on...
• displaying the DashBoard interfaces, refer to “Using DashBoard”.

Configuration Overview
Figure 1 provides a generalized workflow of configuring your Streaming Gateway.

Figure 1  Configuration Workflow

Create and Connect to an EC2 Instance on AWS
The Streaming Gateway operates as an EC2 instance as of version 4.0. There is no hardware to 
install and configure. You must install the Streaming Gateway as an AWS™ EC2 instance first. This 
requires you to:

1. Create a suitable Ubuntu 24.04 EC2 instance on AWS.

2. Upload and install the SSG package.

3. Retrieve the IP address of the EC2 instance.

For More Information on...
• creating and connecting to an EC2 instance, refer to “Getting Started”.
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Add the EC2 Instance to the DashBoard Tree View
You must install the DashBoard software on your PC and manually add the EC2 instance to the Tree 
View. This will then provide you access to the Streaming Gateway interfaces.

For More Information on...
• installing the DashBoard software, refer to “Install DashBoard”.
• adding the EC2 instance to DashBoard, refer to “Add the EC2 Instance as a Device to the 

DashBoard Tree View”.
• the menus and parameters available in DashBoard, refer to “Using DashBoard” and “DashBoard 

Interface Overview”.

Connect to an NTP Server
Once you can successfully access the Streaming Gateway in DashBoard, the next step is to establish 
a connection to an NTP Server. The Streaming Gateway requires an accurate time reference, in 
order to ensure correct watermarking and crediting. Refer to “Configuring the NTP Settings”.

Configure the Sources
Each source is configured independently, allowing you to assign NDI streams as the source for a 
connection. Once all the sources are configured, you can proceed to assign each source to an 
output (destination) to create a connection. Refer to “Configuring the Source for a Connection”.

Configure the Destinations
A destination is created by defining an output from the Streaming Gateway to a specific SRT 
destination. Each SRT destination is configured independently. Refer to “Configuring the 
Destination for a Connection”.

Enable the Connections
The Streaming Gateway supports the workflow of receiving an NDI stream and transmitting an SRT 
video stream. Use the DashBoard interfaces to map a source to a destination, then enable the 
connection to output the SRT stream. This workflow requires you to:

1. Configure a source from an NDI peer. Refer to “To specify an NDI stream as a source”. 

2. Configure a destination to an SRT peer. Refer to “To assign an SRT stream as the destination”.

3. Repeat steps 1 and 2 for each additional connection.

4. Enable each connection. Refer to “To enable a connection”.

For More Information on...
• enabling a connection, refer to “Connection Management”.
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Getting Started
This chapter provides the installation instructions for creating an AWS EC2 instance, installing the 
Streaming Gateway and DashBoard, and instructions on adding the EC2 instance to the Tree View in 
DashBoard.

If you have questions pertaining to the installation of the Streaming Gateway, contact us at the 
numbers listed in “Contacting Ross Video Technical Support”. Our technical staff is always 
available for consultation, training, or service.

 The Streaming Gateway does not run as an application on your computer. Instead, it runs as a 
service that DashBoard connects to and presents the user interface for. DashBoard is required to 
operate the Streaming Gateway.

Additional Software
In addition to the Streaming Gateway software, you should download and install the following 
software applications.

DashBoard

DashBoard is required to configure and use the Streaming Gateway. The latest version of 
DashBoard is available from our website.

NDI® Tools

The latest version of NDI® Tools can be found at ndi.tv. This suite is free to download and has been 
designed to introduce anyone, from end users to professional installers to the world of NDI® 
connectivity. Some NDI® configuration settings are performed using these tools and therefore 
should be installed for Streaming Gateway. 

NDI® Tools is made up of several useful applications, including the following:

• NDI Studio Monitor — for viewing NDI® video sources on your network.
• NDI Access Manager — for managing visibility and accessibility of sources.
• NDI Test Patterns — for generating reference signals.
• NDI Router — for routing NDI® sources to custom outputs.
• NDI Bridge — for sending and receiving sources beyond your local network.
• NDI VLC Plugin — for generating NDI® sources from the VLC media player.

NDI® SDK (NDI Discovery Server)

The NDI® SDK is available at ndi.tv and includes a number of useful utilities.

The NDI Discovery Server is designed to allow you to replace the automatic discovery NDI® uses 
with a server that operates as a centralized registry of NDI® sources.

Using a discovery server is as simple as running the application in Bin\Utilities\x64\NDI Discovery 
Service.exe. This application will then run a server on your local machine that accepts incoming 
connections with senders, finders, and receivers, and coordinates amongst them all to ensure they 
are all visible to each other.

Once NDI Discovery is running, configuration of each device on your network is made by checking 
the Discovery Server box and adding its IP Address within the NDI® Access Manager.
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Overview
This chapter outlines how to:

1. Create a suitable Ubuntu 24.04 EC2 instance on AWS (g4dn.4xlarge, 100GB disk).

2. Upload and install the latest SSG v4 package (ssg-<version>-<date>-<git hash>.install) on the 
instance.

3. Retrieve the IP address of the EC2 instance.

4. Install DashBoard on your Microsoft Windows machine.

5. Add the EC2 instance to the DashBoard Tree View. 

Create and Connect to an EC2 Instance on AWS
This section outlines how to log into the AWS Console, and launch a new EC2 instance.

To create an EC2 instance on AWS

1. Log into the AWS Console:

a. Use your browser to navigate to aws.amazon.com.

b. Log in with your AWS credentials.

2. In the AWS Management Console, select Services > EC2.

3. Launch an EC2 instance:

a. Click Launch Instances (or Launch Instance).

b. Use the Name and Tags fields to give your instance a descriptive name (e.g. ssg-instance).

c. Under Application and OS images (Amazon Machine Image), select Ubuntu Server 24.04 
LTS (HVM), SSD Volume Type.

d. Set the Instance type to g4dn.4xlarge (as required).

e. Under Key pair (login), select an existing key pair or create a new one. 

The key pair is required to connect via SSH.

f. Under Network settings, confirm the VPC and subnet are correct for your setup. 

 If you plan on connecting from the Internet, ensure you have a public IP or an Elastic IP available.

g. Under Configure storage, set the Root volume size to 100GB.

h. Review your settings.

i. Click Launch Instance.

 For the Security group, Ports 22 (ssh), 5254, and any SRT port you wish to use should be allowed.

4. Wait for the Instance to Start.

• AWS will provision the instance. 
• Once it is running, it will be reported in your EC2 Console with a status of Running.

Notice — Keep track of your credentials and IP addresses, and make sure to close any unused ports 
to maintain security. If you run into connectivity issues, double-check your AWS Security Group and local 
firewall settings.
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To connect to your EC2 instance

1. Locate the Public IP or DNS:

a. In the EC2 Management Console, select your instance. 

b. In the Description or Details pane, note the Public IPv4 address or the Public DNS.

2. SSH into the EC2 instance on your local machine (Mac/Linux) connect to the instance. 

For example (Mac/Linux terminal): 

ssh -m hmac-sha2-512 -i /path/to/your_key_pair.pem ubuntu@<EC2-Public-IP-or-DNS>

a. Replace /path/to/your_key_pair.pem with the path to your key file (from step 3e above).

b. Replace <EC2-Public-IP-or-DNS> with your instance’s public address.

Upload and Run the SSG Installer
This section requires you to use scp (Mac/Linux) or an SFTP client (Windows) to upload the file to 
your EC2 instance. Then you can prepare and run the SSG Installer.

To upload the SSG Installer

1. Ensure the file ssg-<version>-<date>-<git hash>.install is on your local machine. 

2. Transfer the Installer to EC2 using scp (Linux/Mac):

scp -o MACs=hmac-sha2-512 -i /path/to/your_key_pair.pem \

ssg-<version>-<date>-<git hash>.install \

ubuntu@<EC2-Public-IP-or-DNS>:~

 This command uploads the file to your home directory on the EC2 instance.

3. Verify the file.

4. Log back into the EC2 instance.

5. To ensure the file is present, run one of the following:

• ls -l   or 
• ls -l ssg-<version>-<date>-<git hash>.install

To make the Installer executable

• Change the file permissions so the Installer can be executed: 
chmod +x ssg-<version>-<date>-<git hash>.install

To run the Installer

• run the script: sudo ./ssg-<version>-<date>-<git hash>.install

To confirm the installation

• Wait for the script to complete.

Retrieve the IP Address of the EC2 Instance
This section outlines how to locate the IP address for your EC2 instance. This information is 
required to add the instance to the DashBoard interface.
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To retrieve the IP address for your EC2 instance

1. Log into the AWS Console:

a. Use your browser to navigate to aws.amazon.com.

b. Log in with your AWS credentials.

2. In the AWS Console, select EC2 > Instances.

3. Select your instance.

4. Make a note of the value reported in the Details > Private IPv4 address field.

Install DashBoard
The installation wizard will enable you to install the DashBoard application on your PC. DashBoard 
will backup and restore your current settings if another version is already installed on the 
computer.

To install DashBoard

1. Launch the DB#.##.#_setup_64 installer on the PC you want to run the Streaming Gateway and 
follow the on-screen instructions.

2. Review the End User Licensing Agreement (EULA) and click I Agree.

3. Review the Eclipse Foundation Software User Agreement and click I Agree.

4. Select the components you want to install and click Next.

It is recommended to leave everything selected.

5. Select where you want the application to be installed and click Next.

You can either accept the default location or click Browse and select a new location.

6. Enter a name for the folder on the Start Menu that you want to use for the application.

7. Click Install.

8. Click Finish to complete the installation.

Add the EC2 Instance as a Device to the DashBoard Tree View
You must manually add the EC2 instance to the Tree View. Once you add the EC2 instance to the 
Tree View, you can access the Streaming Gateway interfaces.

 Launch DashBoard from another instance running in the same VPC as the EC2 instance.

To manually add the EC2 instance to the Tree View in DashBoard

1. From the main toolbar in DashBoard, select File > New > TCP/IP DashBoard Connect or 
openGear Device.

The New TCP openGear Frame Connection dialog opens.

2. In the IP Address field, enter the IP address from “To retrieve the IP address for your EC2 
instance”.

3. Click Detect Frame Information.

 Use the Display Name field to assign a unique name for the EC2 instance.

4. Click Finish to close the dialog.

5. Verify that the softGear Streaming Gateway node displays in the DashBoard Tree View, along 
with the System sub-node below it.
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Licensed Features
The Streaming Gateway has software licenses for enabling functions and features. This chapter 
outlines the available software licensed features, and how to install a product key for a licensed 
feature. 

 Software licenses are managed and validated by a remote server. Contact Ross Technical Support 
for details on 

Overview
The Streaming Gateway provides floating licenses for cloud servers. Floating licensing is integrated 
with the Ross Platform Manager (RPM), and requires a constant connection with the RPM.

The Streaming Gateway re-activates licenses on a regular interval with the RPM. If an activation fails 
as a result of being unable to reach the RPM, the Streaming Gateway will start a 2-day grace period 
before terminating the features. During this time, the Streaming Gateway will operate as normal. A 
reboot will remove any Streaming Gateway grace period in effect and the Streaming Gateway will 
start without any features. If an activation fails as a result of the RPM being unable to reach the 
activation server, the RPM will start a grace period where the Streaming Gateway will be able to 
continue activating the licenses without issues. After the this grace period is over, the features will 
be terminated. The Streaming Gateway can be rebooted safely while the RPM grace period is in 
effect.

 Contact Ross Technical Support for details on the Ross Platform Manager (RPM).

When the Streaming Gateway is rebooted or turned off, it will deactivate all of its licenses with the 
RPM.

Product Keys Overview
The Streaming Gateway Licensing tab in DashBoard indicates the current state of each license. 
These fields will always be populated for a licensed system and warn the users of any changes or 
issues, such as licenses expiring soon (within a week), or if the connection between the Streaming 
Gateway and the RPM has been lost.

 Expired or invalid licenses will result in the immediate termination of all features.

Table 1 provides a brief summary on the types of licensed features available for the Streaming 
Gateway.

Table 1  List of Streaming Gateway Licensed Features

License Description
Platform Basic license for the softGear product line

SG-SGW-NDI-1CH Enables the Streaming Gateway to receive one network stream 
via the NDI protocol 

SG-SGW-SRT-1CH Enables the Streaming Gateway to transmit MPEG-TS streams via 
SRT protocol

Video Scaler Enables the Streaming Gateway to change the video resolution 
and frame rate
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Installing a Product Key
Ross Video uses product keys to control user access to specific Streaming Gateway features. You 
can obtain a key for a Streaming Gateway licensed feature from Ross Video Technical Support.

To install a Streaming Gateway Product Key

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the System sub-node.

4. Select the Licensing tab.

5. Enter the Product Key in the Product Key field.

6. Click Activate.

7. Verify that the Status field updates to Activation Successful and the Licensing Table populates.

The SSG sub-node will now be available in the Basic Tree View of DashBoard under the 
softGear Streaming Gateway node.

Uninstalling a Product Key
Whether your use of Streaming Gateway features has changed, or you are switching to using 
another Streaming Gateway instance, you will need to uninstall the product key that you were 
using.

To uninstall a Streaming Gateway Product Key

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the System sub-node.

4. Select the Licensing tab.

5. Click Deactivate.

6. Click Yes when prompted.

The Product Key is now uninstalled.
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Using DashBoard
The Streaming Gateway interfaces and settings are accessed by expanding the main softGear 
Streaming Gateway node in the Tree View of DashBoard, and then selecting the appropriate 
sub-node. This chapter provides instructions for accessing the sub-nodes of the Streaming Gateway 
and their interfaces in DashBoard.

Accessing the System Interfaces in DashBoard
The System interfaces are access via the System sub-node in the DashBoard Tree View. 
Double-clicking the System sub-nod displays a series of tabs in the right pane of the DashBoard 
window. Use the System interfaces to enable licensed features, connect to an NTP server, and 
monitor the read-only information about your system. 

To display the System interfaces in DashBoard

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the System sub-node.

The Licensing tab is automatically selected.

The Licensing tab provides options to manage the features that require a valid Product Key.
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4. Select the Timing tab.

The Timing tab provides settings to connect to an NTP server to establish accurate timing.

5. Select the Features tab.

The Features tab provides read-only information on the running features.

6. Select the About tab.

The About tab provides general system information, such as the product name, version, and 
enables you to apply a unique identifier to this Streaming Gateway. From this tab you can also 
download an archive of the logs for troubleshooting purposes.
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Accessing the SSG Interfaces in DashBoard
The SSG interfaces are accessed by double-clicking the SSG sub-node. Use the SSG interfaces to 
configure the sources and destinations, enable connections, and monitor the traffic.

To display the SSG interfaces in DashBoard

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the SSG sub-node.

The Connections Control tab is automatically selected. This enables you to specify which 
connections are active (online) or not (offline), and monitor the connections. 
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4. Select the Source Configuration tab.

The Source Configuration tab enables you to manage the input signals that the Streaming 
Gateway will have access to. The tab is organized into two panes. The left pane lists all the 
configured sources in a table format. Selecting a row in this table displays the options for the 
selected source in the right pane of the window.

5. Select the Destination Configuration tab.

The Destination Configuration tab enables you to manage the output signals that the 
Streaming Gateway will have access to. The tab is organized into two panes. The left pane lists 
all the configured destinations in a table format. Selecting a row in this table displays the 
options for the selected destination in the right pane of the window.

6. Select the Configuration tab.

From this tab you can access the Global Settings, API Control, Preset Connections, and About 
sub-tabs (located in the bottom toolbar). By default, the Global Settings sub-tab is automatically 
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selected. Refer to “Configuration Tab” for a detailed explanation of the options contained 
within each sub-tab.

Upgrading the Software
The Streaming Gateway can be upgraded in the field via DashBoard. Contact Ross Technical 
Support before upgrading from versions prior to v4.0. Refer to “Contacting Ross Video Technical 
Support” for contact details.
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Configuring the NTP Settings
The Streaming Gateway requires an accurate time reference to ensure correct watermarking and 
crediting. This chapter outlines how to set the system time of the Streaming Gateway.

Configuring the NTP Settings
You have the option to set the current date and time on the system clocks of the Streaming 
Gateway by using a Network Time Protocol (NTP) server. This requires you to enter the IP address of 
up to two (2) NTP servers. The Streaming Gateway must be able to access these IP addresses to 
acquire the time from an NTP server.

To set the system time of the Streaming Gateway

1. Display the System interface as outlined in “To display the System interfaces in DashBoard”.

2. Select the Timing tab. 

3. In the NTP Server 1 field, enter the IP address of the first NTP server you want to add.

4. If required, in the NTP Server 2 field, enter the IP address of the second NTP server you want to 
add.

5. Click Apply Changes.

6. Wait until the Streaming Gateway is:

• synchronized to the new NTP server, and 
• the NTP Status field reports “OK”.

7. If OK is not reported, check: 

• that the time displayed in the Current Time field is correct;
• that the IP address is correct;
• that the Streaming Gateway has access to the address.
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Configuring the Source for a 
Connection
This chapter outlines how to configure the NDI sources (inputs) for the Streaming Gateway. 

For More Information on...
• the Streaming Gateway destinations, refer to “Configuring the Destination for a Connection”.
• managing your connections, refer to “Connection Management”.

Overview
Each connection is configured independently. Once all the sources are configured, you proceed to 
configure the SRT outputs (destinations). 

 Audio is not supported by the Streaming Gateway in version 4.0.

Configuring the NDI Global Source Discovery
The Global Settings sub-tab (located in the SSG > Configuration tab) provides options for NDI Global 
Source Discovery. If you are using a private group or an external server, ensure that the NDI Global 
Source Discovery is set accordingly. 

To configure the NDI Global Source Discovery on the Streaming Gateway

1. Display the SSG sub-node in DashBoard as outlined in “Accessing the SSG Interfaces in 
DashBoard”.

2. Select the Configuration tab.

 The Discovery Group(s) field is set to Public by default.

 The Discovery & Registration Method is automatically set to Discovery Server. The NDI 
Discovery Server is a tool that allows NDI devices to perform discovery. The user is required to set 
up the NDI Discovery Server independently. Refer to “Additional Software”.
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3. Use the Discovery Server IP/ Host name field to specify the IP address or host name for the 
NDI discovery method. 

4. Reboot the Streaming Gateway.

 After inputting the NDI Discovery Server IP address or host name, you must reboot the Streaming 
Gateway in order to connect to the NDI Discovery Server.

5. Monitor the Status field to ensure the Streaming Gateway establishes a valid connection to 
your NDI Discovery Server. Refer to Table 15 for a list of possible messages.

Specifying an NDI Stream as a Source
By default, there are two sources populated in DashBoard. You may edit one of these preexisting 
sources instead of creating a new one, if desired.

To specify an NDI stream as a source

1. Display the Source Configuration interface as outlined in “Accessing the SSG Interfaces in 
DashBoard”. 

2. Click Create Source.

A new row displays in the source table (left pane) and the DashBoard window updates to 
display the Source Configuration options (right pane).

3. Use the Name field to assign a unique identifier to this source.

The source name is used to identify the available sources on the Destination Configuration tab.

4. Use the Type menu to select NDI.

The Source Configuration area updates to display options for configuring the source as an NDI 
stream.
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5. Click the Update button beside the NDI Source menu. 

This refreshes the list of existing NDI sources.

6. Use the NDI Source menu to select the desired source.

The IP Address field populates with the IP address for the selected source.

 If you want to create an NDI source instead of selecting an existing one, select the Create NDI 
Source box and manually fill the IP Address and Port fields.

7. Click Apply.
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Configuring the Destination 
for a Connection
Each connection requires an SRT destination and the video from a single NDI source. Each SRT 
destination is configured independently. This chapter outlines how to configure the SRT 
destinations (outputs) that will create connections for your Streaming Gateway. 

Before You Begin
To establish an SRT-to-SRT connection, one of the peers must operate in Listener mode while the 
other operates as Caller. The mode of operation for the peer is determined by network 
configuration. It is not important which mode either the source or destination operates in. Keep the 
following in mind:

• The SRT peer operating in Listener mode must be reachable over UDP on the port specified in 
the Local Port field for listener mode. 

• The SRT peer operating in Caller mode simply calls the listener at the specified Target URL 
(Host:Port). 

Refer to Table 14 for further information on the menus and fields involved in assigning an SRT 
stream as the destination.

Assigning an SRT Stream as the Destination
By default, there are two destinations populated in DashBoard. You may edit one of these 
preexisting destinations instead of creating a new one, if desired. 

To assign an SRT stream as the destination

1. Display the Destination Configuration interface as outlined in “Accessing the SSG Interfaces 
in DashBoard”.

2. Click Create Destination.

A new row displays in the destination table (left) and the DashBoard window updates to display 
the Destination Configuration settings for the new destination (right).
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3. Use the Name field to assign a unique identifier to this destination.

This name is used to quickly identify connections on the Connections Control tab.

4. Use the Type menu to select SRT.

The Destination Configuration pane updates to display options for assigning an SRT stream as 
a destination.

5. Use the Mode menu to select either Caller or Listener.

6. Use the Bandwidth Mode options to specify the Bandwidth limits. Choose from the following:

• Hardware Limit — The Streaming Gateway applies the ethernet port bandwidth as the limit.
• Input Rate Limit — The Input Rate and Bandwidth Overhead fields are now editable.
• Manual Limit — The Bandwidth Limit field is now editable. 

7. If the Bandwidth Mode is set to Manual Limit, use the Bandwidth Limit (kbps) field to define 
the maximum sender bandwidth.

8. If the Bandwidth Mode is set to Input Rate Limit:

a. Use the Bandwidth Overhead (%) field to define the recovery bandwidth overhead. 

b. Use the Input Rate (kbps) field to define the anticipated bitrate of your live stream.

9. Perform one of the following:

• If the Mode selected in step 5 was Caller, use the Target URL (Host:Port) fields to define the 
port.

• If the Mode selected in step 5 was Listener, use the Local Port field to define the port.

10. (optional) For configurations in which the Listener expects a specific Stream ID to be present, set 
the Stream ID field on the Caller to define the Stream ID for the connection.

11. Click Video Stream Settings.

The Video Stream Settings window opens.
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12. Use the Video Source menu to select the desired source.

13. Use the PID Option menu to select Auto or Custom.

14. Use the PID Value menu to set a custom PID value if the PID Option is set to Custom.

15. Use the Encoding Profile menu to select the H264 profile to be used.

 If High 4:2:2 is enabled, Intel Quick Sync hardware acceleration will be disabled.

16. Use the Video BitRate(kbps) fields to define the video bitrate and mode. 

To apply video scaling to the output video

1. Select the Video Scaler box.

The Output Resolution and Output Frame Rate menus display.

2. Use the Resolution menu to specify the resolution of the SRT signal.

3. Use the Frame/Field Rate menu to specify the frame rate of the SRT signal.

4. Select the Interlaced box to output interlaced video. 

When this box is not selected, the output is progressive video. This option is only accessible for 
certain Resolution and Frame/Field Rate format combinations. Refer to Table 14 for details.

5. Use the Aspect Ratio Control menu to set the aspect ratio to Letterbox/Pillarbox or Full Frame.

6. Select OK.

The Video Stream Settings window closes.

7. If you are using encryption, continue to “To use encryption”. 

8. If you are not using encryption, continue to “Connection Management”.

To use encryption

1. Select the Configure button for Encrypt Stream.

The Encrypt Stream window opens.

2. Select the Encrypt box.

The Key Length menu and Passphrase field display.

3. Use the Key Length menu to select the desired key length to encrypt the data.
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4. Use the Passphrase field to specify a string between 10-80 characters long. 

 The passphrase must match for both peers.

5. Select Exit to close the Encrypt Stream window.

The Encrypt Stream window closes.

6. Click Apply.
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Connection Management
Once the sources are configured, and the SRT destinations are assigned, you are ready to enable a 
connection. Enable each connection as required. This chapter outlines how to enable a connection, 
edit an existing connection, disable a connection, and delete a connection.

For More Information on...
• the sources for your connections, refer to “Configuring the Source for a Connection”.
• the destinations for your connections, refer to “Configuring the Destination for a Connection”.

Before You Begin
By default, a new connection is disabled (the status is reported as Offline) to ensure that a change in 
settings does not disrupt any downstream equipment or user portals. You must manually enable 
each connection by toggling its Online button on the Connections Control tab.

Enabling a Connection
Enabling a connection requires you to select it from the list of available connections, and click the 
Online button. The connection is then published to your downstream devices.

To enable a connection

1. Display the Connections Control tab in DashBoard as outlined in “Accessing the SSG 
Interfaces in DashBoard”.

2. From the Connections table, select the row for the connection you wish to enable.

3. Click Online (located in the bottom left corner of the Connections table).

The Status fields for the source and destination update to report that the selected connection 
is now enabled.

Disabling a Connection
Clicking the Offline button for a connection immediately stops that session and freezes the output. 
This is helpful:

• to free up bandwidth
• if the source is invalid or missing
• if the source includes data that you do not want to output
• to update the connection settings

To disable a connection

1. Display the Connections Control tab in DashBoard as outlined in “Accessing the SSG 
Interfaces in DashBoard”.

2. From the Connections table, select the row for the connection you wish to disable.

The Selected Connection area updates to display the settings for the connection.

3. Click Offline (located at the bottom of the Connections table).

The Status fields for the source and destination update to report that the selected connection 
is now disabled.
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Editing an Existing Connection
Before editing an existing connection, ensure that it is currently offline (disabled) and not in use by 
downstream equipment or user portals. A connection must be offline before it can be edited.

To edit an existing connection

1. Disable the connection as outlined in “Disabling a Connection”.

2. Edit the source for a connection using the steps in “Configuring the Source for a Connection”.

3. Edit the destination for a connection using the steps in “Configuring the Destination for a 
Connection”.

4. Enable the connection as outlined in “Enabling a Connection”.

 If you no longer want to save changes made to the connection, click Cancel instead of Apply. This 
will revert any changed field to its previous state.

Deleting a Connection
You cannot delete a connection that is currently online (active). You must first disable the 
connection, as outlined in “To disable a connection”, before proceeding to delete it.

To delete a connection

1. Disable the connection as outlined in “Disabling a Connection”.

2. Select the Destination Configuration tab.

3. From the Destinations table, select the row for the connection output you wish to delete. 

4. Click Delete Destination (located at the bottom of the Destinations table).

 If the Source for the deleted connection is no longer used by any other connection, it can also be 
deleted by performing steps 3-4 under the Source Configuration tab.

Troubleshooting
This section briefly summarizes some of the error messages that display on the Connections 
Control interface when creating the connections for your Streaming Gateway. 

Table 2  Connections Control — Possible Error Messages

Message Notes
Destination Does Not Have 
Output Video Enabled

• The output video source is not detected for a destination. 
• Verify that the Output Video box is selected on the destination 

Configuration interface for the destination. 
• Refer to “Configuring the Destination for a Connection”.

Destination is Online • The user attempted to edit a destination that was assigned to a 
connection that is currently online and in use. 

• You must first disable the associated connection before editing 
the destination. 

• Refer to “Disabling a Connection” and “Editing an Existing 
Connection”.
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Source is Online • The user attempted to edit a source that was assigned to a 
connection that is currently online and in use. 

• You must first disable the associated connection before editing 
the source. 

• Refer to “Disabling a Connection” and “Editing an Existing 
Connection”.

Video Source is Invalid • The user attempted to assign a video source that is not available 
(N/A). 

• Refer to “Configuring the Source for a Connection” and 
“Configuring the Destination for a Connection”. 

Table 2  Connections Control — Possible Error Messages (Continued)

Message Notes
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DashBoard Interface Overview
This chapter summarizes the interfaces, tabs, and menus available from DashBoard for the 
Streaming Gateway.

System Interfaces
Double-clicking the System sub-node displays four tabs in the DashBoard window: Licensing, 
Timing, Features, and About. This section provide a summary of each tab.

Licensing Tab
Use the options on the Licensing tab to manage the licensed features that require a valid Product 
Key. (Figure 2)

Figure 2  Example of the Licensing Tab

Table 3 summarizes the options displayed in the Licensing tab.

Table 3  System — Licensing 

Item Parameters Description
Product Key # Used to enter the Product Key in order to 

license the server

Activation Server <text> Used to enter the server the license must 
connect with to confirm its validity

Port # Used to select the Port for the Activation 
Server

Protocol HTTP Selects HTTP for the Activation Server

HTTPS Selects HTTPS for the Activation Server 

Activate Activates the entered Product Key

Deactivate Deactivates the Product Key
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Timing Tab
The Timing tab provides options for configuring a connection to your facility NTP Server. (Figure 3)

Figure 3  Example of the Timing Tab

Status <text> Can report the following:
• the validity of the Product Key used, 
• the result of activation, 
• and the result of checking the license per 

the interval defined by the licensing mode

Name <text> Reports the marketing code for the feature

Description <text> Summarizes the licensed feature

Licensed To # Indicates the device the license applies to

License Key # A character string to obtain an Activation 
Key

Expiry MM/YYYY Reports the expiry date for the feature

Number of Uses # Represents the amount of docker 
containers set up and running for the 
specific feature

Validity Valid/Invalid Reports if the Activation Key is valid and the 
feature is still licensed or not

Feature ID # Provides the license code that you must 
provide to Ross Technical Support

Table 3  System — Licensing  (Continued)

Item Parameters Description
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Table 4 summarizes the fields displayed in the Timing tab.

Table 4  System — Timing 
Item Parameters Description

NTP Status 
(read-only)

OK (Green) Indicates a valid time source is reporting to 
the Streaming Gateway

Apply Changes (Yellow) At least one NTP Server address has 
changed. 
Click Apply Changes to save the new 
setting(s).

Not Running (Red) Software was not able to start NTP client

No Servers Configured 
(Red)

The NTP Server fields are blank

Cannot Resolve Server 
Name (Red)

At least one of the NTP Server host-names 
could not be resolved. It is recommended 
to specify the IP address instead of a 
host-name for the server.

No Time Server Available 
At Address (Red)

At least one NTP Server IP Address does not 
have a valid time server running

Current Time 
(read-only)

Ddd Mmm ## hh : mm : 
ss yyyy GMT

Indicates the encoded date where:
• Ddd represents the day of the week
• Mmm represents the month
• ## represents the day of the month
• hh : mm : ss reports the current encoding 

time as reported by the NTP Server(s)
• yyyy represents the year

NTP Server 1 # Specifies the first Network Time Server 
(NTP) address the Streaming Gateway can 
use for timecode information

NTP Server 2 # Specifies an additional Network Time Server 
(NTP) address the Streaming Gateway can 
use for timecode information

Apply Changes Applies any changes made
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Features Tab
The Features tab enables you to monitor the Streaming Gateway features. (Figure 4)

Figure 4  Example of the Features tab

Table 5 summarizes the fields displayed in the Features tab.

Table 5  System — Features
Item Parameters Description

Name <text> The name of the feature

Version # The version of the feature

Hash <text> The hash of the feature

Buildstamp <text> The buildstamp of the feature

State <text> The current status of the feature

Restart Click the button to restart the feature
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About Tab
The About tab reports product information, manage your configuration files, and access the system 
logs. (Figure 5)

Figure 5  Example of the About Tab

Table 6 summarizes the fields and read-only information displayed in the About tab.

Table 6  System — About

Item Parameters Description
Product Information

Product (read-only) softGear Streaming Gateway

Product Version 
(read-only)

<text> The software build the Streaming Gateway 
is currently running

Product Hash 
(read-only)

<text> The hash of the software build

Frame Name <text> • Assigns a unique identifier to the 
Streaming Gateway. 

• This name displays in the node for the 
Streaming Gateway in the Tree View of 
DashBoard. 

• The default is softGear Streaming 
Gateway. 

• Note that any change to this name may 
take up to one minute to be reflected in 
the Tree View of DashBoard.

Host name #.#.#.# Reports the IP address of the AWS EC2 
instance

Factory Default Reboots the Streaming Gateway and resets any editable fields to the 
factory default values. 
This impacts all tabs except the Ethernet and About tabs. 
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SSG Interfaces
Double-clicking the SSG sub-node displays four tabs in the DashBoard window: Connections 
Control, Source Configuration, Destination Configuration, and Configuration.

Connections Control Tab
The Connections Control tab is organized into four panels (from left to right): a Connections table, 
Connection Information area, Video Source Information area, and Connection Status Details area. 
(Figure 6)

Figure 6  Example of the Connections Control Tab

Connections Table

The Connections table reports a list of active and inactive connections that the user has configured 
using the Sources Configuration and Destinations Configuration tabs. Each table row is a 

Import/Export Configuration

Import/Export Click this button to export a configuration file for the Streaming 
Gateway to your computer, or to import a previously saved 
configuration file from your computer to the Streaming Gateway. The 
export option allows you to save the current configuration to a file on 
your computer, while the import button lets you load a previously 
saved configuration file onto the Streaming Gateway. An import will 
trigger a reboot of the Streaming Gateway.
Note: Only configurations that match the feature set of the currently 
licensed system will be imported.

Logs

Download Exports an archive of the logs to a specified location on your network or 
computer

Table 6  System — About (Continued)

Item Parameters Description
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connection with the assigned source, destination, and a brief status message. Selecting a row 
displays more information in the other areas of the tab.

Table 7 summarizes the read-only fields displayed in the Connections table.

Connection Information

Table 8 summarizes the read-only fields displayed in the Connection Information area. 

For More Information on...
• the available input options, refer to “Source Configuration Tab”.
• the available output options, refer to “Destination Configuration Area”.

Table 7  SSG — Connections Control — Connections Table

Item Description
Name Reports the destination assigned as the output for the connection

SRC Type Identifies the signal type of the input of the connection 

Type Reports the signal type assigned to the destination

Status Reports the connection status of the stream: online (green), offline 
(gray), or warning (yellow) of an error condition

Online Select this button to enable the selected connection

Offline Select this button to disable the selected connection

Table 8  SSG — Connections Control — Connection Information

Item Parameters Description
Current State Online The connection is active and no errors are 

detected. The connection cannot be edited.

Offline The connection is inactive and can be 
edited

Destination Name <text> Reports the unique identifier assigned to 
the output signal of this connection. Used 
to identify the connection in the Manage 
Connections table.

Destination Type SRT Identifies the output of the connection as 
an SRT signal. Refer to Table 14 for details.

Connection Mode <text> This field reports the connection mode that 
is assigned as the output for the connection

Video Format # Indicates the video format of the input 
signal. 
Displays when Video Scaler is not selected.

Resolution # Indicates the resolution set in the Output 
Video Settings. 
Displays when Video Scaler is selected.

Frame Rate # Indicates the frame rate set in the Output 
Video Settings. 
Displays when Video Scaler is selected.
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Video Source Information

Table 9 summarizes the read-only fields displayed in the Video Source Information area.

Connection Status Details

Table 10 summarizes the read-only fields displayed in the Connection Status Details area.

Host:Port # When the Mode is set to Caller, this field 
indicates the host and port used

Local Port # When the Mode is set to Listener, this field 
indicates the port used

H.264 H/W 
Acceleration

<text> Reports if H.264 hardware acceleration Intel 
Quick Sync is in use

Table 9  SSG — Connections Control — Video Source Information

Item Parameters Description
Source Name <text> Reports the unique identifier assigned to 

the input signal of this connection

Source Type SRT Identifies the input of the connection as an 
SRT signal

Source Status Online (Green) The input signal is valid and no errors are 
detected

No input signal detected 
(Yellow)

The specified stream is assigned as an input 
but a valid signal is not detected

Initializing Signal (Yellow) The Streaming Gateway is in the process of 
establishing a connection 

Closed to Signal Server 
(Yellow)

The input is unavailable. 
The connection with the media server is no 
longer valid.

Shared Memory Input 
Error (Red)

The input cannot be connected. 
Toggling the Offline and Online buttons 
may fix this.

Not Initialized (Red) The input is no longer valid. 
Verify that a valid signal is available.

Packets Missing (Red) The input signal is experiencing errors. 
Verify if a valid signal is available.

Offline (Gray) The stream was stopped or is not yet 
initialized. 
Verify your network connections.

Source Format # Reports the input video format 

Table 8  SSG — Connections Control — Connection Information (Continued)

Item Parameters Description
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Table 10  Connections Control — Connection Status Details

Item Parameters Description
Negotiated Latency 
(ms)

# Defines the minimum receiver buffering 
delay before sending an SRT data packet via 
this connection

Packets Sent # Reports the total number of packets 
transmitted by this connection

Packets Sent Lost # Reports the total number of missing 
packets transmitted by this connection

Packets Sent 
Dropped

# Reports the total number of dropped 
packets transmitted by this connection

Packet ACK 
Received

# Reports the total number of acknowledged 
packets that were transmitted by this 
connection and received by the 
downstream SRT device

Packet NACK 
Received

# Reports the total number of packets that 
were transmitted by this connection but not 
received by the downstream SRT device

Send Rate (Mbps) # Reports the packets received by the 
Streaming Gateway and forwarded to the 
processor on the specified connection

Bandwidth (Mbps) # Reports the bandwidth utilization (to the 
nearest 100Mbps) sent from the processor 
to the network links on this connection

RRT (ms) # Reports the detected latency on your 
network (the number of milliseconds that 
passed from when the Streaming Gateway 
sent a network request was sent and an 
acknowledgment was received)

Bytes Sent Total # Reports the amount of data the Streaming 
Gateway sent on the specified connection  
since the Online button was selected
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Source Configuration Tab
The Source Configuration tab is organized into two areas (from left to right): a Sources table, and 
Source Configuration area. (Figure 7)

Figure 7  Example of the Source Configuration Tab

Sources Table

The Sources table reports a list of active and inactive sources that the user has configured. 
Double-clicking a row displays more information in the Sources Configuration area.

Table 11 summarizes the read-only fields displayed in the Sources table.

Sources Configuration

Table 12 summarizes the options when the Type is set to NDI.

Table 11  SSG — Connections Control — Sources

Item Description
Name Reports the source assigned as the input signal for the connection

Type Reports the signal type assigned to the source

Status Reports the connection status of the source: online (green), offline 
(gray), or warning (yellow) of an error condition.

Create Source Select this button to define and add a new source to the database 

Delete Source Select this button to remove the selected source from the database

Table 12  SSG — Source Configuration — Type > NDI 

Item Parameters Description
Status (read-only) Reports the status of the connection: online (green), offline (gray), 

warning (yellow), or error (red)

Name <text> Identifier assigned to the source connection
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Destination Configuration Tab
The Destination Configuration tab is organized into two areas: a Destinations table, and the 
Destination Configuration area. (Figure 8)

Figure 8  Example of the Destination Configuration Tab

Destinations Table

The Destinations table reports a list of active and inactive destinations that the user has configured. 
Double-clicking a row displays more information in the Destinations Configuration area. 

Table 13 summarizes the read-only fields displayed in the Destinations table.

Manual IP/Port Selected Allows you to create a new NDI source to 
use. 
When selected, you must manually enter 
the IP address and port # of the desired 
source.

Cleared Indicates that the source to be used is 
preexisting 

NDI Source <text> Selects an existing source to use as the NDI 
Source

Update Refreshes the list of existing NDI sources

IP Address # Reports the IP address of the selected 
source

Table 13  SSG — Destination Configuration — Destinations 

Item Description
Name Reports the destination assigned as the output signal for the 

connection

Table 12  SSG — Source Configuration — Type > NDI  (Continued)

Item Parameters Description
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Destination Configuration Area

Table 14 summarizes the options when Type is set to SRT.

Src Type Reports the source signal type to this destination

Type Reports the signal type assigned to the destination

Status Reports the connection status of the connection: online (green), offline 
(gray), or warning (yellow) of an error condition

Create Destination Select this button to define and add a new destination to the database 

Delete Destination Select this button to remove the selected destination from the 
database

Table 14  SSG — Destination Configuration — Type > SRT

Item Parameters Description
Status (read-only) Online (green) Reports the status of the connection

Warning (yellow)

Error (red)

Offline (gray)

Name <text> Assigns a unique identifier to the 
connection

Mode Listener Indicates the mode for the source is set to 
Listener. 
When in Listener mode, the Streaming 
Gateway is listening on a port to establish a 
connection.

Caller Indicates the mode for the source is set to 
Caller. 
When in Caller mode, the Streaming 
Gateway sends out a message to the IP 
address and port to connect.

Bandwidth Mode Hardware Limit The Streaming Gateway applies the 
ethernet port bandwidth as the limit

Input Rate Limit The Input Rate and Bandwidth Overhead 
fields are now editable

Manual Limit The Bandwidth Limit field is now editable. 

Bandwidth Limit 
(kbps)

# This field is only editable when the 
Bandwidth Mode is set to Manual Limit. 
Defines the maximum sender bandwidth. 

Target URL 
(Host:Port)

<text>, # Available in Caller Mode. Specifies the 
target URL and port to be used.

Stream ID <text> Available in Caller Mode. Defines the 
Stream ID.

Table 13  SSG — Destination Configuration — Destinations  (Continued)

Item Description
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Bandwidth 
Overhead (%)

# Defines the recovery bandwidth overhead 
percentage. The default is 25%. 
Only applicable when the Bandwidth Mode 
is set to Input Rate Limit.

Local Port # Available in Listener Mode. Specifies the 
local port to be used.

Input Rate (kbps) # Defines the anticipated bitrate of your live 
stream. Only applicable when the 
Bandwidth Mode is set to Input Rate Limit.
The default is 0. When set to 0, the value 
used will be estimated from the rate of the 
input during transmission.

Video Stream Settings

Video Source # Provides a list of the available sources as 
defined using the Sources Configuration tab

PID Option Auto The PID value will be automatically set to 
the default one

Custom Allows you to customize the PID value

PID Value # Defines the PID value when the PID Option 
is set to Custom

H264 Encoder

Encoding Profile Main Defines that the H264 profile used will be 
Main

High 4:2:2 Defines that the H264 profile used will be 
High 4:2:2

Video Bit Rate (kbps) CBR, # Defines the video bitrate and its mode, CBR. 
CBR refers to constant bitrate, meaning the 
bitrate will be kept the same.

VBR, # Defines the video bitrate and its mode, VBR. 
VBR refers to variable bitrate, meaning the 
bitrate will vary. The value is the maximum 
bitrate allowed.

Video Scaler

Video Scaler Selected The video output will be scaled.

Cleared The video output will not be scaled.

Resolution # x # Selects the desired resolution for the 
output. Only displays when Video Scaler is 
selected.

Frame/Field Rate # Selects the desired frame rate for the 
output. Only displays when Video Scaler is 
selected.

Table 14  SSG — Destination Configuration — Type > SRT (Continued)

Item Parameters Description
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Interlaced Selected The video output will be interlaced. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Cleared The video output will be progressive. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Aspect Ratio Control Letterbox/Pillarbox A letterbox will be added to the output 
video when the output aspect ratio is less 
than the input aspect ratio.
A pillarbox will be added to the output 
video when the output aspect ratio is 
greater than the input aspect.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Full Frame The output video will be cut to fit in the full 
frame.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Table 14  SSG — Destination Configuration — Type > SRT (Continued)

Item Parameters Description
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Configuration Tab
The Configuration tab enables you to configure NDI Global Source Discovery for the Streaming 
Gateway. (Figure 9)

Figure 9  Example of the Configuration Tab

Table 15 summarizes the options displayed in the Configuration tab.

Table 15  SSG — Configuration 

Item Parameters Description
NDI Global Source Discovery

Discovery Group Public Identifies the NDI Discovery Group used

External IP/ Host 
name

# Identifies the IP address or host name used 
to discover sources when the SSG is 
operating in the cloud

Discovery & 
Registration Method

Discovery Server The NDI Discovery Server is a tool that 
allows NDI devices to perform discovery. 
The user is required to set up the NDI 
discovery server independently. Refer to 
the NDI SDK documentation for setup 
details.

Discovery Server IP/ 
Host name

# This field identifies the IP address or host 
name for the NDI discovery method. 
After inputting the server IP address or host 
name, the user must reboot their device in 
order to connect to the server.



49 • DashBoard Interface Overview Streaming Gateway Cloud User Guide (v1-rev1)

Status (read-only) OK There is no Discovery Server connected

NDI receiver and sender successfully 
connected to the Discovery Server

Apply Changes There are unsaved changes. Click Apply to 
apply the changes.

Internal error reaching 
discovery server

NDI receiver had an SSG internal error on 
attempting to reach the NDI Discovery 
Server

Lookup failure on 
discovery server name

NDI receiver had a DNS lookup failure for 
NDI Discovery Server

Discovery server not 
reachable

NDI receiver cannot reach the Discovery 
Server

Failure to query 
discovery server

NDI receiver had an internal error querying 
the Discover Server

No response from 
discovery server

NDI receiver connected to the Discovery 
Server but received no response

Unexpected response 
from discovery server

NDI receiver connected to the Discover 
Server but received an unexpected 
response

Table 15  SSG — Configuration  (Continued)

Item Parameters Description
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Third Party Licenses
This chapter contains licenses for third party libraries that are used in the softGear Streaming 
Gateway.

dbus 
Copyright (c) 2013, Georg Reinke (<guelfey at gmail dot com>), Google

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

dhkx 
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

“License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of 
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under 
common control with that entity. For the purposes of this definition,  "control" means (i) the power, direct or indirect, to 
cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) 
or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but 
not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated 
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or 
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor 
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, 
and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sub license, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, 
offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable 
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes 
direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall 
terminate as of the date such litigation is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without 
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and 

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and 

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and 
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the 
Derivative Works; and 

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must 
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or,           
within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents 
of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution 
notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, 
provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and       may provide additional or different license terms 
and conditions      for use, reproduction, or distribution of Your modifications, or      for any such Derivative Works as a whole, 
provided Your use,      reproduction, and distribution of the Work otherwise complies with      the conditions stated in this 
License.

5. Submission of Contributions. 

Unless You explicitly state otherwise,       any Contribution intentionally submitted for inclusion in the Work       by You to the 
Licensor shall be under the terms and conditions of       this License, without any additional terms or conditions.       
Notwithstanding the above, nothing herein shall supersede or modify       the terms of any separate license agreement you 
may have executed       with Licensor regarding such Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the 
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its 
Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or  implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A  PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise,  unless required by 
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of 
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill,  work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting 



Streaming Gateway Cloud User Guide (v1-rev1) Third Party Licenses • 52

such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other 
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

 APPENDIX: How to apply the Apache License to your work.

 To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" 
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on 
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License.   You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software   distributed under the License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.  See the License for the specific 
language governing permissions and   limitations under the License.

Docker
                                 Apache License

                           Version 2.0, January 2004

                        http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of 
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under 
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause 
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or 
more of the      outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but 
not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated 
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or 
additions to that Work or Derivative Works thereof, that is intentionally      submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor 
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, 
and issue tracking systems that are managed by, or on behalf of, the      Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of   this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sub license, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, 
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offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable 
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes 
direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall 
terminate as of the date such litigation is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without 
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and 
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the 
Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must 
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or,          
within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents 
of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution 
notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, 
provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and 
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided 
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. 

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the 
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may 
have executed with Licensor regarding such Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the 
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each      Contributor provides its 
Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise,      unless required by 
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special,      incidental, or consequential damages of any character arising as a result of 
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill,      work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting 
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other 
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" 
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on 
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]
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Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License. You may obtain a copy of the License at    http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.   See the License for the specific 
language governing permissions and    limitations under the License.

WebRTC
FILENAME: LICENSE

============================

Copyright (c) 2011, The WebRTC project authors. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the     distribution.

* Neither the name of Google nor the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Haivision SRT
Mozilla Public License Version 2.0

==================================

1. Definitions

--------------

1.1. "Contributor" means each individual or legal entity that creates, contributes to the creation of, or owns Covered 
Software.

1.2. "Contributor Version" means the combination of the Contributions of others (if any) used by a Contributor and that 
particular Contributor's Contribution.

1.3. "Contribution" means Covered Software of a particular Contributor.

1.4. "Covered Software" means Source Code Form to which the initial Contributor has attached    the notice in Exhibit A, the 
Executable Form of such Source Code Form, and Modifications of such Source Code Form, in each case including portions 
thereof.

1.5. "Incompatible With Secondary Licenses" means (a) that the initial Contributor has attached the notice described in 
Exhibit B to the Covered Software; or (b) that the Covered Software was made available under the terms of version 1.1 or 
earlier of the License, but not also under the terms of a Secondary License.

1.6. "Executable Form" means any form of the work other than Source Code Form. 

1.7. "Larger Work" means a work that combines Covered Software with other material, in      a separate file or files, that is not 
Covered Software.

1.8. "License" means this document.

1.9. "Licensable" means having the right to grant, to the maximum extent possible, whether at the time of the initial grant or 
subsequently, any and     all of the rights conveyed by this License.

1.10. "Modifications" means any of the following:

(a) any file in Source Code Form that results from an addition to, deletion from, or modification of the contents of Covered 
Software; or 

(b) any new file in Source Code Form that contains any Covered Software.

1.11. "Patent Claims" of a Contributor means any patent claim(s), including without limitation, method,     process, and 
apparatus claims, in any patent Licensable by such Contributor that would be infringed, but for the grant of the License, by 
the making, using, selling, offering for sale, having     made, import, or transfer of either its Contributions or its Contributor 
Version.
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1.12. "Secondary License" means either the GNU General Public License, Version 2.0, the GNU    Lesser General Public 
License, Version 2.1, the GNU Affero General Public License, Version 3.0, or any later versions of those licenses.

1.13. "Source Code Form" means the form of the work preferred for making modifications.

1.14. "You" (or "Your") means an individual or a legal entity exercising rights under this    License. For legal entities, "You" 
includes any entity that controls, is controlled by, or is under common control with You. For purposes of this definition, 
"control" means (a) the power, direct    or indirect, to cause the direction or management of such entity, whether by contract 
or otherwise, or (b) ownership of more than fifty percent (50%) of the outstanding shares or beneficial    ownership of such 
entity.

2. License Grants and Conditions

--------------------------------

2.1. Grants

Each Contributor hereby grants You a world-wide, royalty-freestone-exclusive license:

(a) under intellectual property rights (other than patent or trademark) Licensable by such Contributor to use, reproduce, 
make available, modify, display, perform, distribute, and otherwise exploit its Contributions, either on an unmodified basis, 
with Modifications, or as part of a Larger Work; and

(b) under Patent Claims of such Contributor to make, use, sell, offer for sale, have made, import, and otherwise transfer 
either its Contributions or its Contributor Version.

2.2. Effective Date

The licenses granted in Section 2.1 with respect to any Contribution become effective for each Contribution on the date the 
Contributor first distributes such Contribution.

2.3. Limitations on Grant Scope

The licenses granted in this Section 2 are the only rights granted under this License. No additional rights or licenses will be 
implied from the distribution or licensing of Covered Software under this License.

Notwithstanding Section 2.1(b) above, no patent license is granted by a Contributor:

(a) for any code that a Contributor has removed from Covered Software; or

(b) for infringements caused by: (i) Your and any other third party's modifications of Covered Software, or (ii) the 
combination of its Contributions with other software (except as part of its Contributor Version); or

(c) under Patent Claims infringed by Covered Software in the absence of its Contributions.

This License does not grant any rights in the trademarks, service marks, or logos of any Contributor (except as may be 
necessary to comply with the notice requirements in Section 3.4).

2.4. Subsequent Licenses

No Contributor makes additional grants as a result of Your choice to distribute the Covered Software under a subsequent 
version of this License (see Section 10.2) or under the terms of a Secondary License (if permitted under the terms of Section 
3.3).

2.5. Representation

Each Contributor represents that the Contributor believes its Contributions are its original creation(s) or it has sufficient 
rights to grant the rights to its Contributions conveyed by this License.

2.6. Fair Use

This License is not intended to limit any rights You have under applicable copyright doctrines of fair use, fair dealing, or other 
equivalents.

2.7. Conditions

Sections 3.1, 3.2, 3.3, and 3.4 are conditions of the licenses granted in Section 2.1.

3. Responsibilities

-------------------

3.1. Distribution of Source Form

All distribution of Covered Software in Source Code Form, including any Modifications that You create or to which You 
contribute, must be under the terms of this License. You must inform recipients that the Source Code Form of the Covered 
Software is governed by the terms of this License, and how they can obtain a copy of this License. You may not attempt to 
alter or restrict the recipients' rights in the Source Co Deform.

3.2. Distribution of Executable Form

If You distribute Covered Software in Executable Form then:

(a) such Covered Software must also be made available in Source Code Form, as described in Section 3.1, and You must 
inform recipients of the Executable Form how they can obtain a copy of such Source Code Form by reasonable means in a 
timely manner, at a charge no more than the cost of distribution to the recipient; and
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(b) You may distribute such Executable Form under the terms of this License, or sub license it under different terms, 
provided that the license for the Executable Form does not attempt to limit or alter    the recipients' rights in the Source Code 
Form under this License.

3.3. Distribution of a Larger Work

You may create and distribute a Larger Work under terms of Your improvidence that You also comply with the requirements 
of this License forth Covered Software. If the Larger Work is a combination of Covered Software with a work governed by one 
or more Secondary Licenses, and the Covered Software is not Incompatible With Secondary Licenses, this License permits 
You to additionally distribute such Covered Software under the terms of such Secondary License(s), so that the recipient of 
the Larger Work may, at their option, further distribute the Covered Software under the terms of either this License or such 
Secondary License(s).

3.4. Notices

You may not remove or alter the substance of any license notices (including copyright notices, patent notices, disclaimers of 
warranty limitations of liability) contained within the Source Code Form of the Covered Software, except that You may alter 
any license notices tithe extent required to remedy known factual inaccuracies.

3.5. Application of Additional Terms

You may choose to offer, and to charge a fee for, warranty, supportability or liability obligations to one or more recipients of 
Covered Software. However, You may do so only on Your own behalf, and not on behalf of any Contributor. You must make 
it absolutely clear that any such warranty, support, indemnity, or liability obligation is offered by You alone, and You hereby 
agree to indemnify every Contributor for any liability incurred by such Contributor as a result of warranty, supportability or 
liability terms You offer. You may include additional disclaimers of warranty and limitations of liability specific to any 
jurisdiction.

4. Inability to Comply Due to Statute or Regulation

---------------------------------------------------

If it is impossible for You to comply with any of the terms of this License with respect to some or all of the Covered Software 
due to statute, judicial order, or regulation then You must: (a) comply withe terms of this License to the maximum extent 
possible; and (b) describe the limitations and the code they affect. Such description must be placed in a text file included with 
all distributions of the Covered Software under this License. Except to the extent prohibited by statute or regulation, such 
description must be sufficiently detailed for recipient of ordinary skill to be able to understand it.

5. Termination

--------------

5.1. The rights granted under this License will terminate automatically if You fail to comply with any of its terms. However, if 
You become compliant, then the rights granted under this License from a particular Contributor are reinstated (a) 
provisionally, unless and until such Contributor explicitly and finally terminates Your grants, and (b) on an ongoing basis, if 
such Contributor fails to notify You of the non-compliance by some reasonable means prior to 60 days after You have come 
back into compliance. Moreover, Your grants from a particular Contributor are reinstated on an ongoing basis if such 
Contributor notifies You of the non-compliance by some reasonable means, this is the first time You have received notice of 
non-compliance with this License from such Contributor, and You become compliant prior to 30 days after Your receipt of 
the notice.

5.2. If You initiate litigation against any entity by asserting a patent infringement claim (excluding declaratory judgment 
counteraction-claims, and cross-claims) alleging that a Contributor Version directly or indirectly infringes any patent, then 
the rights granted to You by any and all Contributors for the Covered Software under Section2.1 of this License shall 
terminate.

5.3. In the event of termination under Sections 5.1 or 5.2 above, all end user license agreements (excluding distributors and 
resellers) which have been validly granted by You or Your distributors under this License prior to termination shall survive 
termination.

************************************************************************

* 6. Disclaimer of Warranty                                           *

* -------------------------                                           *

* Covered Software is provided under this License on an "as is" basis, without warranty of any kind, either expressed, 
implied, or statutory, including, without limitation, warranties that the Covered Software is free of defects, merchantable, fit 
for a particular purpose or non-infringing. The entire risk as to the quality and performance of the Covered Software is with 
You.

* Should any Covered Software prove defective in any respect, You (not any Contributor) assume the cost of any necessary 
servicing, repair, or correction. This disclaimer of warranty constitutes an    essential part of this License. No use of any 
Covered Software is authorized under this License except under this disclaimer.   

*                                                                      *

************************************************************************

************************************************************************



57 • Third Party Licenses Streaming Gateway Cloud User Guide (v1-rev1)

7. Limitation of Liability                                          *

* --------------------------                                          *

* Under no circumstances and under no legal theory, whether tort (including negligence), contract, or otherwise, shall any 
Contributor, or anyone who distributes Covered Software as permitted above, be liable to You for any direct, indirect, 
special, incidental, or consequential damages of any character including, without limitation, damages for lost profits, loss of 
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses, even if such 
party shall have been informed of the possibility of such damages. This limitation of liability shall not apply to liability for 
death or personal injury resulting from such party's negligence to the extent applicable law prohibits such limitation. Some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so this exclusion and limitation 
may not apply to You.                                    *                                                                      *

************************************************************************

8. Litigation

-------------

Any litigation relating to this License may be brought only in the courts of a jurisdiction where the defendant maintains its 
principal place of business and such litigation shall be governed by laws of that jurisdiction, without reference to its 
conflict-of-law provisions.

Nothing in this Section shall prevent a party's ability to bring cross-claims or counter-claims.

9. Miscellaneous

----------------

This License represents the complete agreement concerning the subject matter hereof. If any provision of this License is held 
to be unenforceable, such provision shall be reformed only to the extent necessary to make it enforceable. Any law or 
regulation which provides that the language of a contract shall be construed against the drafter shall not be used to construe 
this License against a Contributor.

10. Versions of the License

---------------------------

10.1. New Versions

Mozilla Foundation is the license steward. Except as provided in Section10.3, no one other than the license steward has the 
right to modify or publish new versions of this License. Each version will be given distinguishing version number.

10.2. Effect of New Versions

You may distribute the Covered Software under the terms of the version of the License under which You originally received 
the Covered Software under the terms of any subsequent version published by the license steward.

10.3. Modified Versions

If you create software not governed by this License, and you want to create a new license for such software, you may create 
and use modified version of this License if you rename the license and remove any references to the name of the license 
steward (except to note that such modified license differs from this License).

10.4. Distributing Source Code Form that is Incompatible With Secondary Licenses

If You choose to distribute Source Code Form that is Incompatible With Secondary Licenses under the terms of this version 
of the License, the notice described in Exhibit B of this License must be attached.

Exhibit A - Source Code Form License Notice

-------------------------------------------

This Source Code Form is subject to the terms of the Mozilla Public License, v. 2.0. If a copy of the MPL was not distributed 
with this file, You can obtain one at http://mozilla.org/MPL/2.0/.

If it is not possible or desirable to put the notice in a particular file, then You may include the notice in a location (such as a 
License file in a relevant directory) where a recipient would be likely to look for such a notice.

You may add additional accurate notices of copyright ownership.

Exhibit B - "Incompatible With Secondary Licenses" Notice

---------------------------------------------------------

This Source Code Form is "Incompatible With Secondary Licenses", as defined by the Mozilla Public License, v. 2.0.

httprouter 
BSD 3-Clause License

Copyright (c) 2013, Julien Schmidt

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,   this list of conditions and the following 
disclaimer in the documentation   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its   contributors may be used to endorse or promote products 
derived from   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE AREDISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLEFOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS ORSERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVERCAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USEOF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

IXWebSocket
Copyright (c) 2018 Machine Zone, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the   documentation and/or other materials provided with the   distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHTHOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOTLIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

libsamplerate
Copyright (c) 2012-2016, Erik de Castro Lopo <erikd@mega-nerd.com>

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
APARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

mongo-driver
                                 Apache License

                           Version 2.0, January 2004

                        http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
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"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of 
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under 
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause 
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or 
more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but 
not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated 
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or 
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor 
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, 
and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sub license, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, 
offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable 
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s)      
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes 
direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall 
terminate as of the date such litigation is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without 
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and 
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the 
Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must 
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a 
display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the 
NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices 
within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that 
such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and 
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided 
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.
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5. Submission of Contributions. 

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the 
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may 
have executed with Licensor regarding such Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the 
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its 
Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by 
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special,      incidental, or consequential damages of any character arising as a result of 
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting 
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other 
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" 
replaced with your own identifying information. (Don't include the brackets!. The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on 
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the specific 
language governing permissions and limitations under the License.

nlohmann/json
MIT License 

Copyright (c) 2013-2022 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation 
files (the "Software"), to dealing the Software without restriction, including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sub license, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS ORIMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY,FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER 
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,OUT OF OR IN CONNECTION WITH THE SOFTWARE OR 
THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenSLP
The following copyright and license is applicable to the entire OpenSLP project (libslp, slpd, and related documentation):

Copyright © 2000 Caldera Systems, Inc
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All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 
in the documentation and/or other materials provided with the distribution.

Neither the name of Caldera Systems nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE CALDERA SYSTEMS OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

spdlog
The MIT License (MIT)

Copyright (c) 2016 Gabi Melman.                                       

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation 
files (the "Software"), to dealing the Software without restriction, including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sub license, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT. IN 
NO EVENT SHALL THEAUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

-- NOTE: Third party dependency used by this software --

This software depends on the fmt lib (MIT License), and users must comply to its license: 
https://github.com/fmtlib/fmt/blob/master/LICENSE.rst

zmq4
Copyright (c) 2013-2018, Peter Kleiweg

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the   documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "ASIS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITEDTO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
APARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, ORPROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OFLIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THISSOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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Glossary
The following terms are used throughout this guide:

DashBoard — refers to the DashBoard Control System.

Destination — refers to the output.

DHCP — refers to Dynamic Host Configuration Protocol.

EFA — refers to Elastic Fabric Adapter.

NTP — refers to Network Time Protocol.

Operator and User — refer to the person who uses the Streaming Gateway.

RPM — refers to the Ross Platform Manager.

Source — refers to the input.

Tree View — refers to the area located to the far left of the DashBoard window. This area displays 
devices in a tree structure. 

URI — refers to Uniform Resource Identifier.
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